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Task Management
In the life cycle of a project, there are various non-technical tasks that are vital to the successful management and
completion of the project, such as allocation of resources and allocation of time to the tasks and to meetings. Enterprise
Architect helps you as a project manager or as a team member to record and monitor such tasks.

Facilities
Enterprise Architect provides a range of project management facilities as described in this table.
Facility

Description

Manage Project Resources

Resources are the people who work on a project. You can assign roles and allocate
tasks to them, which helps you to track effort and estimate time to complete tasks.
You can also define the effort, risks and metrics to support resource management.
You add, modify and delete resources using the Resource Allocation window.

The Gantt View

In Enterprise Architect, you can visualize elements and assigned project resources
easily in a Gantt Chart format, to review the breakdown of work for a specific
project and for specific sections of the project. The Project Gantt View illustrates a
project schedule by showing the start and finish dates of assigned resources, so that
you as Project Manager can quickly see the current project status using the
percent-complete bar shading and the percent-complete, resource name and status
columns. Information can be filtered, and overdue items can quickly be highlighted
and identified. You can also access specialized versions of the Gantt View from
diagrams, Packages and the Personal Tasks list.

Project Task Allocation

A particular feature of the Project Gantt View is the facility to review the allocation
of work to elements in the project, focusing on either the elements that require
work, or the resources required to perform the work.

Review Personal Tasks

Using the Personal Tasks view, each team member can record, review and manage
their personal work within the project.

Project Management
Windows

Enterprise Architect provides four specialized windows to help you to define each
of the management quantities associated with an element in the model, namely:
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·

Resources - the people who work on a project, who can be assigned roles and
allocated tasks

·
·
·

Effort - the effort expended in work on the element
Risks - the risks associated with the element, and
Metrics - the metrics measured for an element
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Project Resources
Resources are the people who work on a project. They can be assigned roles and allocated tasks, which enables tracking
of effort and estimation of time to complete. You also define the effort, risks and metrics to support resource
management.
Resources are added, modified and deleted using the Resource Allocation window.

Access
Ribbon

Construct > Task Management > Resource Allocation

Uses
Use to
Allocate a resource to an element.
Record additional project management information for an element.
Obtain a report of resource allocation details.
Configure Project Management data and populate the drop-down lists used on the Project Management widows.

Notes
·

In the Corporate, Business and Software Engineering, System Engineering and Ultimate editions of Enterprise
Architect, if security is enabled you must have 'Configure Resources' permission to update and manage project
resources, effort, metrics and risks

(c) Sparx Systems 2015 - 2017
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Resource Allocation
In developing a model, people (or resources) in a number of roles might perform tasks on model structures. As a Project
Manager, you can assign resources to tasks on elements (including Packages) in the model, planning and monitoring the
work that they do within the timeframe you have allocated for that work to be completed. You can do this using the
Project Management and/or Project Gantt View facilities.

Access
First, select an element, then:
Ribbon

Construct > Task Management > Gantt > Element View > right-click on element >
Assign Resource, or
Construct > Task Management > Resource Allocation > :

New

Enter resource allocation details for an element
Option
Resource

Action
Either:

·

Type in the name of the resource being assigned to work associated with the
element, or

·

Click on the drop-down arrow and click on the name of the resource

If you want to assign more than one resource to the task on the element, you follow
a slightly different procedure.
Role or Task

Either:

·
·
Start Date

Type in the role name or task performed by the selected resource, or
Click on the drop-down arrow and click on the role performed by the resource

This field defaults to today's date.
If you want to assign a different start date for the task:
1.

Click on the drop-down arrow.

2.

If necessary, click on the Left or Right Arrow to select the previous or next
month.

3.

Click on the appropriate day of the month as the start date.

The field immediately changes to the selected date.
End Date

This field defaults to today's date.
If you want to assign a different end date for the task:
1.

Click on the drop-down arrow.

2.

If necessary, click on the Right Arrow to select the next month.

3.

Click on the appropriate day of the month as the end date.

The field immediately changes to the selected date.

(c) Sparx Systems 2015 - 2017
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Complete %

If the task is already in progress, type in the current percentage completion.

Expected Time

Type in the number of whole time units the task is expected to take. (The value
must be an integer, so you cannot record part units.)
The unit of time you adopt is by agreement within the project, and depends on the
granularity of the work being recorded. Most tasks are completed in a number of
hours or a number of days; use the smallest practical unit that you can record as a
whole number.
Apply the same units as used for the 'Allocated Time' and 'Time Expended' fields.

Allocated Time

Type in the number of time units the task can be spread over. (The value must be an
integer, so you cannot record part units.)
The unit of time you adopt is by agreement within the project, and depends on the
granularity of the work being recorded. Most tasks are completed in a number of
hours or a number of days; use the smallest practical unit that you can record as a
whole number.
Apply the same units as used for the 'Expected Time' and 'Time Expended' fields.

Time Expended

(When the task is eventually 100% complete, you will type in the number of time
units it actually took. The value must be an integer, so you cannot record part
units.)
The unit of time you adopt is by agreement within the project, and depends on the
granularity of the work being recorded. Most tasks are completed in a number of
hours or a number of days; use the smallest practical unit that you can record as a
whole number.
Apply the same units as used for the 'Expected Time' and 'Allocated Time' fields.

Description

Type (and, if you prefer, format) a description of the work being done by the
resource (this text is also displayed in the Notes window, but it cannot be edited in
that window).

History

(As the task progresses, you add text to this tab to record the activities, progress,
problems and outcomes of the task. This text is also displayed in the Notes window,
but it cannot be edited in that window.)

(Toolbar icon)

(Project Management window toolbar.)
Click on this icon to save the data you have entered and to add the entry to the
Resource list in the left column of the window.

OK

('Assigned Resources' dialog.)
Click on this button to save the data you have entered, and close the dialog.

Cancel

('Assigned Resources' dialog.)
Click on this button to discard the data you have entered, and close the dialog.

Help

('Assigned Resources' dialog.)
Click on this button to display the Assign Multiple Resources Help topic.

Notes
(c) Sparx Systems 2015 - 2017
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·

If you allocate resources to Use Cases, the information you enter contributes to the Use Case Estimation calculation
for estimating the project size in terms of time, resources and cost

·

To edit existing Resource Allocation items for this element, click on the required item in the:
- 'List' panel to the left of the window, in Item mode
- List, in List mode
- Project Management folder in the Element Browser window - if this window is not displayed, click on the
Browse Element icon
in the Project Management window toolbar; resource allocation item icons have an 'R' in the bottom right corner

·

To delete existing Resource Allocation items for an element, click on the item and click on
toolbar

(c) Sparx Systems 2015 - 2017
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Assign Multiple Resources
When you have a large unit of work associated with an element - such as a Package element - you might want to assign
several resources to that element to perform that unit of work. You can assign each person individually, but if the
resources have the same role or task you can assign all of them together in one operation, using the 'Assigned Resources'
dialog.

Access
First, select an element, then:
Ribbon

Construct > Task Management > Gantt > Element View > right-click on element >
Assign Resource, or
Construct > Resource Allocation > :
New

(to show List view) > Right-click > Add

Assign multiple resources to an element
Option
Resource

Action
(To assign a single resource, simply type in the name or click on the drop-down
arrow and select the name from the list. In Project Management, it is simpler to
assign single resources directly through the Resource Allocation window.)
For multiple resources, click on the
dialog.

button to display the 'Assign Resource'

1.

Select the checkbox against each resource to assign to the element; to select all
resources listed, click on the Select All button.

2.

Click on the OK button to close the dialog and add the selected resources to the
'Resource' field.

The 'Resource' field now shows the selected resources, but grayed out. The
drop-down arrow also is not active. To change the resources in the field, click on
the
Role or Task

Either:

·
·
Start Date

button again and select/clear the appropriate checkboxes.

Type in the role name or task that is common to all the selected resources, or
Click on the drop-down arrow and click on the role that is common to all the
resources

This field defaults to today's date.
If you want to assign a different start date for the task:
1.

Click on the drop-down arrow.

2.

If necessary, click on the Left or Right Arrow to select the previous or next
month.

3.

Click on the appropriate day of the month as the start date.

The field immediately changes to the selected date.

(c) Sparx Systems 2015 - 2017
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This field defaults to today's date.
If you want to assign a different end date for the task:
1.

Click on the drop-down arrow.

2.

If necessary, click on the Right Arrow to select the next month.

3.

Click on the appropriate day of the month as the end date.

The field immediately changes to the selected date.
Complete %

If the task is already in progress, type in the current percentage completion.

Expected Time

Type in the number of time units the task is expected to take. (The value must be an
integer, so you cannot record part units.)
The unit of time you adopt is by agreement within the project, and depends on the
granularity of the work being recorded. Most tasks are completed in a number of
hours or a number of days; use the smallest practical unit that you can record as a
whole number.
Apply the same units as used for the 'Allocated Time' and 'Time Expended' fields.

Allocated Time

Type in the number of time units the task can be spread over. (The value must be an
integer, so you cannot record part units.)
The unit of time you adopt is by agreement within the project, and depends on the
granularity of the work being recorded. Most tasks are completed in a number of
hours or a number of days; use the smallest practical unit that you can record as a
whole number.
Apply the same units as used for the 'Expected Time' and 'Time Expended' fields.

Time Expended

(When the task is eventually 100% complete, you will type in the number of time
units it actually took. The value must be an integer, so you cannot record part
units.)
The unit of time you adopt is by agreement within the project, and depends on the
granularity of the work being recorded. Most tasks are completed in a number of
hours or a number of days; use the smallest practical unit that you can record as a
whole number.
Apply the same units as used for the 'Expected Time' and 'Allocated Time' fields.

Description

Type (and, if you prefer, format) a description of the work being done by the
resources (this text is also displayed in the Notes window, but it cannot be edited in
that window).

History

(As the task progresses, you add text to this tab to record the activities, progress,
problems and outcomes of the task. This text is also displayed in the Notes window,
but it cannot be edited in that window.)

Apply

Click on this button to apply the changes to the currently-displayed element on a
diagram, without closing the dialog.

New

Click on this button to clear the fields on the dialog so that you can define a new
resource allocation.

Previous

Click on this button to display the previous resource record in the sequence.

Next

Click on this button to display the next resource record in the sequence.

(c) Sparx Systems 2015 - 2017
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OK

Click on this button to save the data you have entered, and close the dialog.

Close

Click on this button to discard the data you have entered, and close the dialog.

Help

Click on this button to display this Help topic.

Notes
·

When the resource details are displayed on the Project Gantt Chart or 'Project Management' dialog, each resource
has their own record containing, initially, the same data; however, each resource can be monitored and their progress
recorded separately

·

If you assign resources that are already in a multiple resource assignment to the selected element, a prompt displays
for you to confirm that you are updating the assignment of that resource, or now omitting that resource from the
current assignment

(c) Sparx Systems 2015 - 2017
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Effort Management
In Enterprise Architect, the Project Manager can allocate effort (as time) to work on a given model element. To select the
element to which to allocate effort, click on the required element in the Project Browser.

Access
Ribbon

Construct > Change Management > Effort : New

Enter effort allocation details for an element
Option

Action

Effort

Type the name or a brief description of the effort.

Type

Type in the effort type or click on the drop-down arrow and select the type. The
selection list is drawn from the global Effort Type list, but any new efforts you type
in this field are not added to the list.

Time

Type in the amount of time the effort is expected to expend.

<notes>

Type in any additional notes or description of this effort.
This text is also displayed in the Notes window, but it cannot be edited in that
window.

risksave

Click on this icon in the Project Management window toolbar to save the new effort
definition.

Notes
·

To edit existing Effort items for this element, click on the required item in the:
- 'List' panel to the left of the window, in Item mode
- List, in List mode, or
- Project Management folder in the Element Browser window - if this window is not displayed, click on the
Browse Element icon
in the Project Management window toolbar; effort item icons have an 'E' in the bottom right corner

·

To delete existing Effort items for an element, click on the item and click on

·

Although Enterprise Architect does not currently provide detailed reports on effort within a model, you can use the
Automation Interface or similar tools to create your own custom reports based on effort information you enter

(c) Sparx Systems 2015 - 2017
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Risk Management
In Enterprise Architect, the Project Manager can allocate the possible weighting of defined risks to work on a given
model element, which might impact work on that element.
To select the element to which to allocate risk weightings, click on the required element in the Project Browser.

Access
Ribbon

Construct > Change Management > Risks : New

Enter risk details for an element
Option

Action

Risk

Type the name or a brief description of the risk.

Type

Type in the risk type or click on the drop-down arrow and select the type. The
selection list is drawn from the global Risk Type list, but any new risks you type in
this field are not added to the list.

Weight

Defaults to the weighting for the defined type. You can change this weighting if
necessary.

<notes>

Type in any additional notes or description of this risk.
This text is also displayed in the Notes window, but it cannot be edited in that
window.

risksave

Click on this icon in the Project Management window toolbar to save the new risk
definition.

Notes
·

The risks described here are not the same as those represented by Risk elements; the risks are properties of a single
element, whilst the Risk element represents something that can impact a range of other elements

·

If you select a global risk type from the 'Type' drop-down list and the associated 'Weight' field is empty, the default
Weight value is allocated to the 'Weight' field on the Risks window

·

To edit existing Risk items for this element, click on the required item in the:
- 'List' panel to the left of the window, in Item mode
- List, in List mode
- Project Management folder in the Element Browser window - if this window is not displayed, click on the
Browse Element icon in the Project Management window toolbar; risk item icons have an 'Ri' in the bottom
right corner

·

To delete existing Risk items for an element, click on the item and click on

(c) Sparx Systems 2015 - 2017
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Although Enterprise Architect does not currently provide detailed reports on risks within a model, you can use the
Automation Interface or similar tools to create your own custom reports based on risk information you enter

(c) Sparx Systems 2015 - 2017
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Metrics
The Project Manager can allocate the possible weighting of defined metrics to work on a given model element.
To select the element to which to allocate a metric weighting, click on the required element in the Project Browser.

Access
Ribbon

Construct > Change Management > Metrics : New

Enter metric details for an element
Option

Action

Metric

Type the name or a brief description of the metric.

Type

Type in the metric type or click on the drop-down arrow and select the type. The
selection list is drawn from the global Metric Type list, but any new metrics you
type in this field are not added to the list.

Weight

Defaults to the weighting for the defined type. You can change this weighting if
necessary.

<notes>

Type in any additional notes or description of this metric.
This text is also displayed in the Notes window, but it cannot be edited in that
window.

risksave

Click on this icon in the Project Management window toolbar to save the new
metric definition.

Notes
·

If you select a global metric type from the 'Type' drop-down list and the associated 'Weight' field is empty, the
default Weight value is allocated to the 'Weight' field in the Metrics window

·

To edit existing Metric items for this element, click on the required item in the:
- 'List' panel to the left of the window, in Item mode
- List, in List mode
- Project Management folder in the Element Browser window - if this window is not displayed, click on the
'Browse Element' icon in the Project Management window toolbar; metric item icons have an 'M' in the
bottom right corner

·
·

To delete existing Metric items for an element, click on the item and click on

in the window toolbar

Although Enterprise Architect does not currently provide detailed reports on metrics within a model, you can use the
Automation Interface or similar tools to create your own custom reports based on metric information you enter

(c) Sparx Systems 2015 - 2017
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Effort Types
When setting up the project management parameters for monitoring work on elements, you can create types of effort to
add to the global list of effort types that can be assigned to any element in the model. You can also select and edit
existing effort types. The global list of effort types displays in the 'Type' drop-down list on the 'Effort' page of the Project
Indicators window.

Access
Open the 'Project Indicators' dialog using one of the methods outlined here, then select the 'Effort' tab.
Ribbon

Configure > Reference Data > Project Types > Project Indicators : Effort

Add a new effort type to the global list
Click the 'New' button to define a new Effort type
Option

Action

Effort

Type the name of the effort type. (Or, to edit an existing effort type, click on the
effort name in the Defined Effort Types panel.)

Description

Type a short description of the effort type.

Weight

Type the default weighting to apply to the effort type.

<note>

Type any additional information on the effort type.

Save

Click on this button to save the changes that you have made to the dialog.

New

Click on this button to clear the data fields ready to define a new effort type.

Delete

Click on an entry in the Defined Effort Types panel, and click on this button to
immediately delete the effort type.

Close

Click on this button to close the 'Project Indicators' dialog. If you have not saved
your changes, the system prompts you to save or abort those changes.

Notes
·

Although Enterprise Architect does not currently provide detailed reports on effort within a model, you can use the
Automation Interface or similar tools to create your own custom reports based on effort information you enter

·

You can transport effort types between models, using the 'Configure > Model > Transfer > Export Reference Data'
and 'Import Reference Data' ribbon options

(c) Sparx Systems 2015 - 2017
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Metric Types
Enterprise Architect enables you to add a metric type to the global list of metric types that can be assigned to any
element in the model. The global list of metric types displays in the 'Type' field drop-down list on the Metrics window.

Access
Open the 'Project Indicators' dialog using one of the methods outlined here, then select the 'Metric' tab.
Ribbon

Configure > Reference Data > Project Types > Project Indicators : Metric

Add a new metric type to the global list
Click the 'New' button to define a new Metric
Option

Action

Metric Type

Type the name of the metric type. (Or, to edit an existing metric type, click on the
metric name in the Defined Metrics panel.)

Description

Type a short description of the metric type.

Weight

Type the default weighting to apply to the metric type.

<note>

Type any additional information on the metric type.

Save

Click on this button to save the changes that you have made to the dialog.

New

Click on this button to clear the data fields ready to define a new metric type.

Delete

Click on an entry in the Defined Metrics panel, and click on this button to
immediately delete the metric type.

Close

Click on this button to close the 'Project Indicators' dialog. If you have not saved
your changes, the system prompts you to save or abort those changes.

Notes
·

Although Enterprise Architect does not currently provide detailed reports on metrics within a model, you can use the
Automation Interface or similar tools to create your own custom reports based on metric information you enter

·

You can transport metric types between models, using the 'Configure > Model > Transfer > Export Reference Data'
and 'Import Reference Data' ribbon options

(c) Sparx Systems 2015 - 2017
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Risk Types
Using Enterprise Architect you can add a risk type to the global list of risk types that can be assigned to any element in
the model. The global list of risk types displays in the 'Type' field drop-down list on the 'Risks' page of the Project
Indicators window.

Access
Open the Project Indicators window using one of the methods outlined here, then select the 'Risk' page.
Ribbon

Configure > Reference Data > Project Types > Project Indicators : Risk

Add a new risk type to the global list
Click on the New button to define a new Risk
Option

Action

Risk Type

Type the name of the risk type. (Or, to edit an existing risk type, click on the risk
name in the 'Defined Risks' panel.)

Description

Type a short description of the risk type.

Weight

Type the default weighting to apply to the risk type.

<note>

Type any additional information on the risk type.

Save

Click on this button to save the changes that you have made to the dialog.

New

Click on this button to clear the data fields ready to define a new risk type.

Delete

Click on an entry in the 'Defined Risks' panel, and click on this button to
immediately delete the risk type.

Close

Click on this button to close the 'Project Indicators' dialog. If you have not saved
your changes, the system prompts you to save or abort those changes.

Notes
·

Although Enterprise Architect does not currently provide detailed reports on risks within a model, you can use the
Automation Interface or similar tools to create your own custom reports based on risk information you enter

·

You can transport risk types between models, using the 'Configure > Model > Transfer > Export Reference Data' and
'Import Reference Data' ribbon options

(c) Sparx Systems 2015 - 2017
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Project Task Allocation
Using the Project Gantt View, you can review the allocation of work to elements in the project, focusing on either the
elements that require work, or the resources required to perform the work. The view primarily shows information that is
entered through other windows and dialogs, but once a record exists in the view you can edit it and, for example, add to
or change the resources on an element.

Access
Ribbon

(c) Sparx Systems 2015 - 2017
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The Project Gantt View
In Enterprise Architect, you can visualize elements and assigned project resources in a Gantt Chart format, to review the
breakdown of work for a specific project and for specific sections of the project. The Project Gantt View illustrates a
project schedule by showing the start and finish dates of assigned resources, so that a Project Manager can quickly see
the current project status using the percent-complete bar shading and the percent-complete, resource name and status
columns. Information can be filtered, and overdue items can quickly be highlighted and identified.
You can also access specialized versions of the Gantt View from diagrams, Packages and the Personal Tasks list.

Access
Ribbon

Construct > Task Management > Gantt

Gantt View
This example shows four resources, two of whom are working in different capacities on one task, and two on another
task. The resource names and roles are listed in the left panel of the chart, together with the actual percentage completion
of each person's work on the task. In the right panel of the chart, completed work is indicated by the green section of the
bar, work yet to be completed but not yet due is indicated in blue, and work not completed and overdue is indicated in
red (as a result of the option to highlight overdue work being applied).

Tabs of the Gantt View
The Project Gantt View has three tabs, the first two of which use the Gantt chart itself to show the progress of work
against the resources performing the work or the elements having the work performed on them. (Other variations of the
Gantt chart do not have these separate tabs.)
View

Detail

Resource View

When you initially open the Gantt View, it defaults to the 'Resource View' tab, in
which the focus is on the current commitments of each allocated resource in the
project.

Element View

The Element View lists the elements in the project that have resources assigned to
them, and the resources assigned to each element.

(c) Sparx Systems 2015 - 2017
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A Resource report shows how your resources are deployed in your project,
displaying a list of all elements that have resources allocated to them.

Gantt View Facilities
The facilities of the Project Gantt View are common to the Resource and Element Views, and in some cases to all three
tabs, as described here.
Option
Display tasks for today
only, or for another day
only

Action
Right-click on the display and select the option:

·

'Show Only Active Tasks for Today' - to show only tasks that are in progress
today

·

'Show Only Active Tasks for Other Day' - to show only tasks that were in
progress on a specific day in the past, or that are scheduled to be in progress on
a day in the future; a calendar dialog displays from which you select the day to
examine

Display the properties of
the element to which a
resource is assigned

Right-click on the element entry and select the 'Show Element Properties' option.

Display the Resource
Allocation details for an
element or resource

Right-click on the entry and select the 'Show Task Properties' option.

Display the Resource
Allocation records for an
element

(Also available in the Report View.) Right-click on the entry and select either of the
context menu options:

The 'Properties' dialog for the element displays.

The 'Assigned Resources' dialog displays; you can edit the details and, if necessary,
change the resource allocated to the element.

·

'Show Element Resource Allocation window' (if the window is closed or
hidden)

·

'Find Task in Element Resource Allocation window' (if the window is visible
but showing the details of another element)

The Resource Allocation window displays, with the details of the selected entry
shown in the fields and the other resource allocations for the element listed in the
left-hand panel.
You can edit the details and, if necessary, change the resource allocated to the
element.
Assign a new resource to
an element

Right-click on an element in the display, and select the 'Assign Resource' option.

Change the scale of the
display

By default, the Gantt Chart shows periods of time in units of days of the month,
each date column being approximately one centimetre wide. Weekends have a
darker fill color.

The 'Assigned Resources' dialog displays; complete this as for the Resource
Allocation window.

You can change the scale of the date columns by clicking on the column header,
pressing Ctrl and rolling the mouse wheel. As you do this:

(c) Sparx Systems 2015 - 2017

·

At one extreme the date columns expand to approximately 2.5 centimetres, and
the date header shows the full date in dd/mm/yyyy format

·

Rolling to the other extreme changes the scale of the column from date through
week, labeled month, numbered month and labeled year to numbered segments
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of a decade
This allows you to represent a wide range of tasks on a single chart and to condense
or expand the view - in conjunction with filters - to investigate the short term and
longer term work clearly.

Change the duration of a
task, on the Gantt Chart

You might want to make broad adjustments to the timeline of an event, which you
can easily do on the Gantt Chart itself. For example, the resource is ill, or another
resource has taken over other tasks that the resource was allocated to. In neither
case has the task itself changed, but in the first case the resource needs a longer
elapsed time in which to complete the task, and in the second they have less other
work to do and can finish the task sooner.
To make these adjustments, you simply drag the right end of the time bar further or
back along the chart. This changes the task end date to wherever you drag the time
line to, and adjusts the division into complete and incomplete/overdue work to
maintain the percentage completion value. The work time allocated to the task does
not change.
If you drag the left end of the time line, this moves the whole line without changing
its length or proportions; you are just indicating that the task started earlier or later
and will finish earlier or later by the same amount of time.

Grouped work

A resource is likely to be allocated to several tasks either simultaneously or
consecutively. In the Resource View the tasks assigned to a resource are grouped
under the resource name, and a narrow group bar displays in gray on the chart
against the name, spanning the period from when work is scheduled to begin on the
first task to when work is scheduled to finish on the final task.
Similarly, a body of work, represented by an element, might involve several
resources starting and finishing at different points. The resources are grouped under
the element name and the group bar displays on the chart against the element name,
spanning the period from when the first resource is scheduled to start work to when
the last resource is scheduled to complete work on the task.
If any adjustments are made that impact the initial start point or final completion
point of the work, the end of the group bar automatically adjusts. If any task or
resource in the group is overdue, the group bar turns red to reflect that there is a
potential problem in the allocated work.

Filter the display to
exclude elements by status

(This feature takes effect under your user ID.)
Right-click on the window and select the 'Apply Element Status Filter' option.
The 'Excluded Status Types' dialog displays; select the checkbox against one or
more statuses to exclude elements having those statuses from the list.
You can select every checkbox at once by clicking on the Select All button, and
clear all selections by clicking on the Clear All button.
Click on the OK button to immediately apply the filter, which stays in effect until
you specifically change it.

Filter the display to include
elements having certain
properties

Right-click on the list and select the 'Show Filter Bar' option.
The Filter Bar displays underneath the heading bar. Type a text string in the field
above a column to immediately filter the list for entries that have the text string in
the values in that column.
To delete a filter string altogether, click on the blue cross at the right of the field.
If you no longer want to use the filter bar, right-click on the list and select the 'Hide
Filter Bar' option.

Filter the display by Start
or Completion date
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The display default is to show current tasks for which the end date has not yet
occurred. Right-click on the list and select one of the options:
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·

'Include Completed Tasks Within the Last ...' - to display incomplete tasks and
tasks completed only within the specified period; you can set this period to 7,
30 or 90 days, or you can include all completed tasks, or hide all completed
tasks

·

'Include Future Tasks Starting in ...' - to display current incomplete tasks and
completed tasks (depending on the setting of the 'Include Completed Tasks
Within the Last ...' option) and future tasks that have been recorded and are due
to start within the next period; you can set this period to 7, 30 or 90 days, or
you can show all tasks that have been recorded but are not yet due to start

Right-click on the display and select the 'Display Highlight For Overdue items'
option and one of its sub-options:

·

'Show in Red' - to display the uncompleted percentage of the task bars for
overdue items on the Gantt chart in red

·

'Show in Red to Current Date' - to extend the task bars of the overdue items to
today's date, and display them in red

·

'None' - to cancel any overdue item highlighting that has been set

Display ONLY overdue
tasks

Right-click on the display and select the 'Show Overdue Items Only' option.

Refresh the report

Right-click on the entry and select the 'Refresh' option.

The display shows only those items for which the end date has passed but that are
not 100% complete. These items do not have red highlighting.

The content of the display is refreshed and collapsed to element or resource level.
Reposition the Gantt chart
to automatically show the
end date of a selected
allocation

Right-click on the display and select the 'Go to | Auto Sync with Task End Date'
option.

Reposition the Gantt chart
to show the start date or
end date of an allocation,
or today's date

Right-click on the entry and select the required option:

Whilst this option is selected (with a tick next to it), whenever you click on an
allocation the display adjusts to show the end date of the task in the center of the
chart.

·
·
·

'Go To | Task Start Date'
'Go To | Task End Date'
'Go To | Today's Date'

The display shifts to put the required date in the center of the chart.
Locate the element in the
Project Browser

(Also available in the Report View.) Right-click on the element name and select the
'Find in Project Browser' option.
The area of the Project Browser containing the element is brought into focus and
expanded, and the element is highlighted.

Send a Model Mail to the
resource

It is possible to send a Model Mail directly from the Project Gantt View to a
selected resource if the resource's Author name matches their:

·
·

Enterprise Architect security user ID (Security has been enabled) or
Their workstation login ID (Security has not been enabled)

Right-click on the resource or one of their activities and select the 'Post Model
Message' option. This opens a Model Mail message addressed to the resource, for
you to complete and send.
Save an image of the Gantt
chart to file
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Right-click on the tab and select the 'Save Image to File' option.
The 'Save As Image' dialog displays, on which you specify the file name, location
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and graphics file type to save to.

Save an image of the Gantt
chart to the clipboard

Right-click on the tab and select the 'Copy Image to Clipboard' option.
You can paste the image from the clipboard into your preferred graphics package.

Notes
·

Items in the list pane can be filtered; right-click on the column headings in the list pane to toggle the Filter Bar
between hidden or shown, or to edit the filter

(c) Sparx Systems 2015 - 2017
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Resource View
The 'Resource View' tab shows the current commitments of each allocated resource in the project as a list of allocation
records and a Gantt chart of the progress of the allocations.
The display initially shows the resources and their overall commitment; click on the 'plus-box' to the left of the name of
the resource to expand the entry to show the elements and the allocation period for each element.
The display shows both complete allocations and those that are still in progress; an internal filter hides completed
allocations two weeks after the end date, and incomplete allocations one month after the end date. Tasks you can perform
include checking the:

·
·
·
·
·

Dates on which specific resources or all resources are currently allocated
Elements to which each resource is allocated
Dates on which a resource is allocated to work on a specific element
General progress of the resource in completing the work
Specific details of the allocation of a resource to an element and task or role

Access
Ribbon

(c) Sparx Systems 2015 - 2017

Construct > Task Management > Gantt : Select the 'Resource View' tab
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Element View
The 'Element View' tab of the Project Gantt View lists the elements in the project that have resources assigned to them. It
shows the resources assigned to each element as a list of allocation records and as a Gantt chart of the progress of the
allocations. An allocation can be partial, in that a role or task is assigned but no specific resource has been identified.
The display initially shows the elements and their overall resource commitment; click on the 'plus-box' to the left of the
name of the element to expand the entry to show the resources and the allocation period for each resource. You can then:

·
·
·
·
·
·

Check the dates on which specific elements have resources currently allocated
Check which resources are currently allocated to an element
Assign further resources to the element
Check the dates on which a resource is allocated to work on a specific element
Check the general progress of the resource in completing the work
Check the specific details of the allocation of a resource to an element and task or role

The display shows both complete allocations and those that are still in progress; an internal filter hides completed
allocations two weeks after the end date.
The 'Element View' complements the 'Resource View' and 'Personal Tasks View' of work allocation on the project.

Access
Ribbon

Construct > Task Management > Gantt > Element View or
Design > Diagram > Gantt View

Context Menu

Right-click on a diagram | Switch to Gantt View
Project Browser | Right-click on Package | View as Gantt

(c) Sparx Systems 2015 - 2017
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Report View
The Report View shows how your resources are deployed in your project, displaying:

·
·
·
·
·

A list of all elements that have resources allocated to them, and the type of each element
The resource allocated, and the role played by that resource
The start and end dates of the allocation
The time allocated, expected and expended
The percentage completion of the allocation

You can tailor the displayed information by:

·
·
·
·
·

Hiding columns of information
Grouping types of information
Filtering the data by status
Filtering the data by start date or end date
Filtering any column to show only a specific value

Having displayed the information you require, you can print it.

Access
Ribbon

Construct > Task Management > Gantt : Select the 'Report View' tab

Report View Options
Option
Run the report

Action
Click on the first icon in the Report View toolbar (the rotating arrows).
The report results display.
If you have the report open for a while, you can update the information; either:

·
·
Adjust column headings

Run the report again or
Right-click on the content and select the 'Refresh' option

Drag and drop column headings into the sequence you require.
Right-click on the column headings and select the 'Field Chooser' option, to add or
remove columns using the 'Field Chooser' dialog.

Group entries by column
heading

Right-click on the column headings and select the 'Enable Group Box' option, to
cluster the report information according to your preferred hierarchy of column
headings.

Filter columns

Either:

·
·

(c) Sparx Systems 2015 - 2017

Click on the third toolbar icon from the right (the spy glass), or
Right-click on the column headings and select the 'Toggle Filter Bar' option
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The filter field displays at the top of every column.
Type in whatever text string you require in the appropriate column to filter the
report to show only entries containing that text string in that column.

Filter by degree of
completion

In the first field in the toolbar, click on the drop-down arrow and select one of these
values:

·
·

'All' - Display all entries regardless of degree of completion

·

'Above cut-off' - Display only those entries that are more than a certain
percentage complete

·

'Below cut-off' - Display only those entries that are less than a certain
percentage complete

'Completed' - Display only those entries where the allocation is 100%
completed

In the second field in the toolbar, either type a threshold value or increment to the
value using the up/down arrows, to set the percentage completion for the
'Above/Below cut-off' options.
Filter according to start/end
date

Click on the fourth toolbar icon from the right (the funnel).
The 'Resource Filters' dialog displays.
In the 'Start Date' and/or 'End Date' field, click on the drop-down arrow and select
the appropriate qualifier:

·
·
·
·

'After'
'Before'
'Equal To'
'Not Equals'

In the date fields, click on the checkbox to activate the fields and either type in the
day, month and year or click on the drop-down arrow to select the date from a
calendar.
The fields have an AND relationship; an entry must satisfy both date criteria before
it is displayed.
Print the report

Either:

·
·

Click on the second toolbar icon from the right (the printer) or
Right-click on an entry in the report and select the 'Print' option

The 'Print' dialog displays, on which you specify the printer to use and the
characteristics of the print job.

(c) Sparx Systems 2015 - 2017
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Progress Bars
Progress bars are horizontal bands that show the degree of completion of a task or process. They give a quick indication
of the current status of, for example, projects, tasks or budgets, which can be useful for checking how close a task or
project is to completion or if a project is coming close to hitting its total allowed budget.
Progress bars can be especially useful in large projects that consist of multiple smaller projects, as you can display within
one element separate bars showing the degree of completion of each sub-project and of the main project, giving you an
overview of progress at a single glance. Separate elements within the diagram can contain further progress bars for the
metrics of the individual projects, adding levels of detail that can, again, be assessed in a brief review.
In Enterprise Architect, progress bars are implemented using Tagged Values on elements.

Release 10.2.5
Total Completion

59%
Budget

Total Cost

$270,000
Projects

Project Anubis
Project Hades

Project Hades
Cost

Project Anubis
Cost

$150,000

Progress

37% complete
Tasks

82% complete
Tasks

Deploy

Deploy

Design

Design

Help Topics

Help Topics

Implement

Implement

(c) Sparx Systems 2015 - 2017

$180,000
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Using Progress Bars
You can add progress bars to any element that can show compartments and that can display any numerical value within a
range, when displayed on a diagram.
Progress bars can be used to display things such as:

·
·

The current progress of a task or project
How much of project's budget has been used

By default a progress bar will display a value between 0 and 100 (inclusive); however, it is possible to adjust both the
minimum and maximum values to set any range of values required.
This illustration shows an example of a default progress bar:
Project Alpha
Progress

Creating a Progress Bar using a new Tagged Value
Use this procedure to create a progress bar using a simple Tagged Value that you create immediately from scratch.
Step

Action

1

On a diagram, create an element that can display compartments (such as a Requirement or Feature) and
add a simple Tagged Value to it.

2

From the Tagged Values window open the tag's notes and add 'Type=ProgressBar;' (including the
semi-colon) and then click on the OK button.

(You can add further options to the Tagged Value, as described in the Additional Progress Bar Options
table.)
3

Click on the element and either press Ctrl+Shift+Y or right-click and select the 'Features and Properties >
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Feature and Compartment Visibility' option. The 'Feature and Compartment Visibility' dialog displays.
4

Select the 'Tags' checkbox in the 'Show Element Compartments' panel, then click on the OK button.
The progress bar will now be shown on the element on the diagram, with the Tagged Value name above
the bar.

5

In the Tagged Values window, indicate progress by typing a number between 1 and 100 into the 'Value'
field for the tag. On the diagram, the appropriate length of the progress bar is filled in green.

Creating a Progress Bar from the 'UML Types' dialog
You can also define a progress bar Tagged Value from the 'UML Types' dialog that can then be applied to any element,
without having to set the Tagged Value notes each time.
Step

Action

1

Select the 'Configure > Reference Data > UML Types' ribbon option to display the 'UML Types' dialog
and click on the 'Tagged Value Types' tab.

2

In the 'Tag Name' and 'Description' fields, type a name and description for the Tagged Value. In the
'Detail' field type the option parameters and their values for the Tagged Value. Click on the Save button
and on the Close button.

(The option parameters are described in the Additional Progress Bar Options table.)
3

Select the 'Start > Tagged Values' ribbon option to open the Tagged Values window (if it is not already
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Page 31 of 42

Created with Enterprise Architect

User Guide - Task Management

30 June, 2017

open).
On a diagram select an element, then in the Tagged Values window click on the
Value) button.

(New Tagged

In the 'Tag' field of the Tagged Value dialog, click on the drop-down arrow and select the Tagged Value
you created in step 2, then click on the OK button.
4

On the diagram, right-click on the element and select the 'Features & Properties | Feature and
Compartment Visibility' option to display the 'Feature and Compartment Visibility' dialog.

5

Select the 'Tags' checkbox and click on the OK button.

6

In the Tagged Values window, change the number in the 'Value' field a few times, clicking off the field
each time. Notice the effect this has on the progress bar.

Additional Progress Bar Options
A default progress bar will show the Tagged Value name and reflect values in the range 0-100. You can change the range
values if required, and display text to the right of the bar if more information has to be provided. Use these parameters to
enhance the progress bar.
Parameter
MinVal

Description
Use the MinVal option to set the lowest allowed value to be represented on the
progress bar.

·

Syntax: MinVal=<number>;

A progress bar with the setting MinVal=10; will start at 10. Values lower than 10
will not be shown on it.
If a maximum value (MaxVal) has been defined, the progress bar will show any
values between MinVal and MaxVal (inclusive); otherwise, the maximum value
will default to MinVal + 100. So, if MinVal=10, the progress bar can show values
between 10 and 110 (inclusive).
MaxVal

Use the MaxVal option to set the highest allowed value to be represented on the
progress bar.

·

Syntax: MaxVal=<number>;

A progress bar with the setting MaxVal=300; will show values up to and including
300. Values higher than 300 will not be shown.
If a minimum value (MinVal) has been set, the progress bar will show any values
between MinVal and MaxVal (inclusive); otherwise the minimum value will
default to 0. So, if MaxVal=300 the progress bar can show values between 0 and
300 (inclusive).
Text

(c) Sparx Systems 2015 - 2017

Use the Text option to define additional text to display on the right hand side of the
progress bar. The text might be a resource name or the current take up of the total
allowed budget of a project.

·

Syntax: Text=<text>; - displays the defined text string, such as 'David Brown's
Tasks'

·

Syntax: Text=#Value#; - displays the value of the progress bar Tagged Value,
such as '462' (where the Tagged Value name itself might indicate the type of
value or unit)
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·

Syntax: Text=<text> #Value# <text>; - displays the value of the progress bar
Tagged Value with text before and/or after it, such as '$<value> of $100,000'

This illustration shows a number of examples of using the Text option.
Project Alpha
Development

$150,000 / $300,000

Implement

Terry

Marketing

$250,000 / $300,000

Progress

Compartment

80% Complete

By default, progress bars in an element display together in a separate compartment
from other types of Tagged Value (provided that the diagram and/or element are set
to display tag compartments).
When there are several progress bars on an element, each relating to a different
factor of the project, it can become harder to distinguish between them. In these
cases it is possible to set the progress bars to display in specific compartments in
order to increase clarity. This also provides an additional level of labeling. So you
might have an element relating to costs, and two or more compartments that
indicate costs of different departments, where the department name is reflected in
the compartment name. Or compartments that each contain two or more progress
bars indicating, say, the costs and percentage completion of tasks in each
department.

·

Syntax: Compartment=<name>;

To add multiple progress bars to the same compartment simply give the progress
bars the same compartment name.
This example shows the element from the Text parameter example, but with the use
of compartments to aid in readability.

Project Alpha
Progress

80% Complete
Budget

Development

$150,000 / $300,000

Marketing

$250,000 / $300,000
Tasks

Implement

Terry

Progress Bars with MDG Technologies
Progress bars can also be created within MDG Technologies to define a consistent set of progress bars for use with
multiple projects.
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Personal Tasks
Using the Personal Tasks view, you can record and manage your personal work within the project. This view displays
information based upon your identity as a defined Author on the project.

Access
Ribbon

Start > Today > My Gantt

Work Category
Category

Detail

Allocated Work

Presents a Gantt chart on which you record the work that you are currently engaged
in.

Project Tasks

Enables you to monitor and maintain the work tasks that have been assigned to you,
or that you have created yourself.

(c) Sparx Systems 2015 - 2017
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Review Allocated Work
The 'Allocated Work' tab lists the elements to which your model Author ID has been allocated as a resource, where your
Author ID is the same as:

·
·

Your Enterprise Architect security user ID, if security has been enabled, or
Your workstation login ID if security has not been enabled

For each element, the tab:

·

In the left-hand panel lists the roles or tasks assigned to you as a resource on that element, for which the 'Complete
%' field value is less than '100'

·

In the right hand panel displays a Gantt chart showing your progress in performing each role or task

You can add further work items for an element through the 'Allocated Work' tab; however, you cannot delete any
records. A record is no longer listed when the 'Complete %' field value is '100'.
You or your supervisors can also add records through the Resource Allocation window.

Access
Ribbon

Start > Today > My Gantt > Allocated Work

Select Allocated Work options
Option
Review element properties

Action
Double-click on the element name.
(Alternatively, right-click on the element name and select the 'Show Element
Properties'option.)
The 'Properties' dialog for the element displays; review the pages as required.

Review resource task
details

Double-click on the task item.
(Alternatively, either:

·
·

Double-click on the progress bar for the item on the Gantt chart, or
Right-click on the task or role name and select the 'Show Task Properties'
option)

The 'Assigned Resources' dialog displays, which has the same content, format and
functions as the Resource Allocation window, in 'Item' mode.
Should it be necessary to reassign the item to another resource, click on the
drop-down arrow on the 'Resource' field and select the appropriate 'Author ID';
when you save the changes, the item no longer appears in the list of tasks assigned
to you.
Create new task item

Right-click on the element name and select the 'Add Resource' option.
The 'Assigned Resources' dialog displays, with your Author ID in the grayed-out
'Resource' field.
Complete the dialog as for the Resource Allocation window.
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Your work item can be edited in a number of places in Enterprise Architect, such as
the Project Task Allocation window and the 'Resource Allocation' tab; the element
to which it is assigned can be edited in these and many other areas.
To refresh the display with any changes made elsewhere, right-click on the display
and select the 'Refresh' option.

Display the Resource
Allocation records for the
element

Right-click on the entry and select either of the options:

·

'Show Element Resource Allocation window' (if the window is closed or
hidden)

·

'Find Task in Element Resource Allocation window' (if the window is visible
but showing the details of another element)

The Resource Allocation window displays, with the details of the selected entry
shown in the fields and the other resource allocations for the element listed in the
left-hand panel.
You can edit the details and, if necessary, change the resource allocated to the
element.
Display tasks for today
only, or for another day
only

Filter the display by Start
or Completion date

Identify overdue tasks
amongst the items

Right-click on the display and select the option:

·

'Show only Active tasks for today' - to show only tasks that are in progress
today

·

'Show only Active tasks for another day' - to show only tasks that were in
progress on a specific day in the past, or that are scheduled to be in progress on
a day in the future; a calendar dialog displays from which you select the day to
examine

The display default is to show current tasks for which the end date has not yet
occurred. Right-click on the list and select one of the options:

·

'Include Completed Tasks Within the Last ...' - to display incomplete tasks and
tasks completed only within the last period; you can set this period to 7, 30 or
90 days, or you can include all completed tasks, or hide all completed tasks

·

'Include Future Tasks Starting in ...' - to display current incomplete tasks and
completed tasks (depending on the setting of the option above) and future tasks
that have been recorded and are due to start within the next period; you can set
this period to 7, 30 or 90 days, or you can show all tasks that have been
recorded but are not yet due to start

Right-click on the display and select the 'Display Highlight For Overdue items'
option and one of its sub-options:

·

'Show in Red' - to display the uncompleted percentage of the task bars for
overdue items on the Gantt chart in red

·

'Show in Red to Current Date' - to extend the task bars of the overdue items to
today's date, and display them in red

·

'None' - to cancel any overdue item highlighting that has been set

Display ONLY overdue
tasks

Right-click on the display and select the 'Show Overdue Items Only' option.

Locate the element in the
Project Browser

Right-click on either the element or the work item and select the 'Find in Project
Browser' option.

The display shows only those items for which the end date has passed but that are
not 100% complete. These items do not have red highlighting.

The appropriate Package hierarchy expands in the Project Browser, and the selected
element is highlighted.
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Reposition the Gantt chart
to automatically show the
end date of a selected
allocation

Right-click on the display and select the 'Go to | Auto Sync with Task End Date'
option.

Expose hidden sections of
the work item progress

Some items might operate over a long period of time, and you might not be able to
display the complete progress line for the item in the Gantt chart.

Whilst this option is selected (with a tick next to it), whenever you click on an
allocation in the 'Allocated Work' tab the display adjusts to show the end date of the
task in the center of the chart.

To locate the start point, expected end point, or today's date on the progress line for
an item, right-click on either the item or the progress line and select the appropriate
option:

·
·
·

'Go To | Task Start Date'
'Go To | Task End Date'
'Go To | Today's Date'

The Gantt chart shifts left or right to position the required point in the center of the
display.
Execute Scripts

If scripts have been defined for analyzing the task data, click on the 'Scripts' option
to display the list of script names. Click on the appropriate name to execute the
script on the selected item or items.

Filter the work items

You can refine the list of work items to show only those containing text that
matches the filter item.
Right-click on the tab and select the 'Show Filter Bar' option.
The filter bar displays at the top of the panel; type in the filter text.
As you type, the items listed and the Gantt chart are filtered to show only items
where the item names match the text string.
The filter does not operate on the element names.
If you do not want to use the filter, right-click on the tab and select the 'Hide Filter
Bar' option.

Capture an image of the
Allocated Work data as a
graphics file

Right-click on the tab and select the 'Save Image to File' option.

Copy an image of the
Allocated Work data to the
clipboard

Right-click on the tab and select the 'Copy Image to Clipboard' option.

(c) Sparx Systems 2015 - 2017

The 'Save As Image' dialog displays, on which you specify the file name, location
and graphics file type to save to.

You can paste the image from the clipboard into your preferred graphics package.

Page 37 of 42

Created with Enterprise Architect

User Guide - Task Management

30 June, 2017

Monitor Your Tasks
The 'Project Tasks' tab lists the tasks that you either:

·
·

Own, or
Are assigned to

You can use the tab to review the status and progress of tasks that you are responsible for, and to modify and filter the
display of task information. You can create the tasks through the:

·
·
·

'Project Tasks' tab itself
'Tasks' tab of the Project Status window
Project Tasks view of the Resource Calendar

Access
Ribbon

Start > Today > My Gantt > Project Tasks

Make selections from the options
Option

Action

Add or Modify a task

You add or modify a task through the 'Task Detail' dialog, which displays when you
double-click on an entry (edit) or blank line (create).

Delete a task

Right-click on the message and select the 'Delete' option.
You are prompted to confirm the deletion.

Select columns

Right-click on the column headings and select the 'Field Chooser' option, which
enables you to add or remove specific columns from the display.
You can also click on the column headings and drag them across the header bar to
reposition the columns in a different sequence.

Reorganize tasks in the list

Either:

·

Click on the column heading and click on the arrow head to list items in order
or reverse order, or

·

Right-click on the column headings and select the 'Enable Group Box' option
to organize the messages into groups

You can also use the filter bar to filter the display on an appropriate column value,
such as the value 'New' in the 'Status' column; to display or hide the filter bar,
right-click on the column headings and select the 'Toggle Filter Bar' option.
Set persistent Status filter

Right-click on the tab and select the 'Set term filter' option.
The 'Filter by Status' dialog displays, which enables you to select to list tasks of any
status or only of one specific status.
The filter you set persists when you close the Personal Tasks window or exit from
Enterprise Architect.
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Right-click on the tab and select the 'Print List' option.
The 'Print' dialog displays, on which you specify the local printer and the print
characteristics.
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Project Management Windows
The Project Management windows help you to define these quantities associated with an element contained in the model:

·
·
·
·

Resources - the people who work on a project, who can be assigned roles and allocated tasks
Effort - effort expended in work on the element
Risks - risk associated with the element
Metrics - metrics measured for an element

A separate window displays for each of the four quantities.

Access
Ribbon

Construct > Task Management > Resource Allocation
Construct > Change Management > Effort
Construct > Change Management > Risks
Construct > Change Management > Metrics

Toolbar Options
You can operate on individual items in any of the four Project Management windows, using the Project Management
toolbar.

Icon

Action

New

Create a new item.

Save

Save changes to an item.

Save As New

Duplicate an existing entry.
You must change an item's Role for this to become enabled.

Delete

Delete an item from the list.

Sort

Sort the items in the list into alphabetical order.

Print

Print item data from the list.

Browse Element

Display the Element Browser window for the selected element, to list and select the
project management items for the element.

Show/Hide Properties

Swap between detailed and summary window styles.

Help

Show help contents for this window.
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Notes
·

Click on an element in the Project Browser to switch to the project management information for that element in the
Project Management windows

·

The windows have two formats:
- List mode - provides a detailed list showing several columns of information
- Item mode - a summary list plus an editor to add or edit information for a single selected item

·
·

Toggle between these modes using the Show/Hide Properties button in the window toolbar

·

Right-click on the list to view the context menu, which you can use to add and delete items in the window

Columns in the item list can be reorganized, added, removed, grouped, filtered and sorted using the options provided
in the List Header facilities
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